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Warranty
All products manufactured by Mindman are under warranty regarding 

defective materials for a period of one year, starting from the date of delivery 

to the original purchaser.

Warning
Mindman assumes no liability for damages resulting from the use of this 

product. Mindman reserves the right to change this manual at any time 

without notice. The information published by Mindman is believed to be 

accurate and reliable. However, no responsibility is assumed by Mindman for 
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resulting from its use.

Copyright
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Trademark
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Contact us
If there has any question, please contact Mindman right away. Thanks.
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1.1 Manual structure
 1. Overview section

 2. Basic safety information

1.2 Typography habits
 List: Enumeration is displayed as a list with bullets.

 • Vocabulary 1

 • Vocabulary 2

 Action: The action description is represented by a front triangle.

 The result of the action is represented by an arrow.

  Military action description 1

  Action results

  Military action description 2

 The step program can also be displayed numerically in parentheses.

 (1) Step 1

 (2) Step 2

 Syntax: Digit

 Decimal numbers are displayed without additional indicators (e.g.,123), Hexadecimal 
number display with additional indicator hex (Such as: 00hex) Or with prefix "0X" 
(Such as: 0×00)

 Cross reference: Cross referencing indicates where additional information about this topic 
can be found.

1.3 Symbol
 Explanatory note: This symbol indicates a general note.

 Pay attention: This symbol indicates the most important safety notice.

1.4 Acronym
 FNI : Network interface

 EMC : Electromagnetic compatibility

 FE : Functional earthing

1.5 Viewing angle deviation
 The product views and explanations in this manual may deviate from the actual product. 

1. Review  
This manual is organized by organization, so the chapters are connected to each other.

 I : Standard input

 O : Standard output

 CIEFB: CC-Link IE Field Basic
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2.1 Module overview

2.2 Electrical connections

2. Guide

No. Name Code Description

1 Power connector PWR M12, A-Coded (male) 4PIN, communication module and solenoid 
valvepower supply

2 Bus communication 
interface OUT M12, D-Coded (female) 4PIN, PROFINET, EtherNet/IP, EtherCAT, CIEFB

3 Bus communication 
interface IN M12, D-Coded (female) 4PIN, PROFINET, EtherNet/IP, EtherCAT, CIEFB

4 DIP switch − Protocol switching, IP addressand coil settings

5 Identification board − Device identification board

6 LEDstatus indicator − Indicate running status

No. Function

1 UA Solenoid valve power supply 24V

2 GND Valve terminal/solenoid valve ground 0V

3 US Valve island power supply 24V

4 GND Valve terminal/solenoid valve ground 0V

No. Function

1 Tx+ Send data +

2 Rx+ Receive data +

3 Tx- Send data -

4 Rx- Receive data -

1 2 3

4 5 6

RUN

ERR

L/A IN

L/A OUT

MS/SF

NS/BF

ACT1

LK1

ACT2

LK2

US

UA

PWR

X100

X100 X10

007F11

X1

ECT

9 0

PN

E/IP

E/IP  PN

ECT  CIE

CIE

INOUT

Power connector

1

2

3

4 1

2

3

4

Bus communication 
interface (OUT / IN)
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3.1 Operating conditions

3.2 Electric data

3.3 Communication specifications

3.  Technical Data

Item Parameter

Working temperature -10~+50°C

Working humidity 35~85%RH (No condensation)

Working atmosphere No corrosive gas

Storage temperature -20~+60°C

Withstand voltage 500 VAC (1 minute)

Insulation resistance 500 VDC, ≥10MΩ

Waterproof level IP54

Item Parameter

Power consumption of valve island 
(Ius) ≤0.1A (21.6~26.4VDC)

Total powerconsumption of ≤4A (22.8~26.4VDC)

Output low level NPN(+COM)

Solenoid valve type Single circuit less than 600mA withsurge protection 24V 
solenoid valve

Single load ≤0.4V

Item Parameter

Protocol PROFINET, EtherNet/IP, EtherCAT, CIEFB

Cable type Shielded twisted pair cable minimumSTP CAT5/STP CAT 5e,  
in line with IEEE 802.3

Data transfer rate
100Mbps (PROFINET/ EtherCAT)

10Mbps/ 100Mbps (elf-adaptive EtherNet/IP, CIEFB)

Number of outputcoils Up to 48 channels

File format PROFINET:XML
EtherCAT:XML

EtherNet/IP: EDS
CIEFB: CSPP
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4.1 IP setting

4. Dial Code Settings

 The default domain under different protocols as shown in the table below. Set the last 
digit of the IPaddress by dialing.

EtherNet/IP protocol

Dial code to set the last digit of IP to X100=1, X10=2, X1=3, 
and the IP address under is 192.168.1.123

CIEFB protocol

Dial code to set the last digit of IP to X100=6, X10=2, X1=3, 
and the IP address under 192.168.3.123 needs to subtract 500

Letter of agreement Default domain

EtherNet/IP 192.168.1.xxx

PROFINET Invalid

EtherCAT Invalid

CIEFB 192.168.3.xxx

X100 X10 X1

0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1

X100 X10 X1

0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1
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4.2 Protocal switch setting

4.3. Coil number setting

 The color of LED_V9 above the DIP switch X100 indicates the current protocol

 Steps:

 1. The equipment is powered off, dial 900;

 2. Power on the equipment and wait for 15s;

 3. The equipment is powered off, and the dialing setting protocol is carried out  
    according to the above table

 4. Power on the equipment and wait for 30s; The device is powered off,  
    dial the corresponding IP address (PROFINET, EtherCAT are invalid);

 1. The equipment is powered off, dial code 950；

 2. Power on the device and wait for the green light inside the dial to flash;

 3. After the green light flashes, turn the dial switch to set the number of coils 
    (3S after stopping dialing, the set value takes effect)

 To

 4. Power off the device, dial the corresponding IP address 
    (PROFINET, EtherCAT are invalid);

X100

LED_V9

X10 X1

No. X100 X10 X1 Letter of agreement LED_V9

1 0~2 0~9 0~9 EtherNet/IP Green

2 3 0 0 PROFINET Orange

3 4 0 0 EtherCAT blue

4 5~7 0~9 0~9 CIEFB white

0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1
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5.1 Coil definition

5. Communication Module Data

 As shown in the figure, define the upper coil as A0~A15 from left to right; 
thelower coil as B0…B15 from left to right;

A0

B0

A1

B1

A2

B2

A3

B3

A15

B15

................

................
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5.2 Enter diagnostic data

Byte
Bit

Remark
7 6 5 4 3 2 1 0

0 − − − US over-
voltage

UA over-
voltage

Operating 
temp.

US under-
voltage

UA under-
voltage −

1 B3 A3 B2 A2 B1 A1 B0 A0

Short circuit 
diagnosis 

0 normal
1 short circuit

2 B7 A7 B6 A6 B5 A5 B4 A4

3 B11 A11 B10 A10 B9 A9 B8 A8

4 B15 A15 B14 A14 B13 A13 B12 A12

5 B19 A19 B18 A18 B17 A17 B16 A16

6 B23 A23 B22 A22 B21 A21 B20 A20

7 B3 A3 B2 A2 B1 A1 B0 A0

Open circuit 
diagnosis

0 normal
1 short circuit

8 B7 A7 B6 A6 B5 A5 B4 A4

9 B11 A11 B10 A10 B9 A9 B8 A8

10 B15 A15 B14 A14 B13 A13 B12 A12

11 B19 A19 B18 A18 B17 A17 B16 A16

12 B23 A23 B22 A22 B21 A21 B20 A20

 EtherNet/IP, PROFINET, EtherCAT protocol
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Byte
Bit

Remark
7 6 5 4 3 2 1 0

0 − − − US over-
voltage

UA over-
voltage

Operating 
temp.

US under-
voltage

UA under-
voltage −

Byte
Bit

Remark
7 6 5 4 3 2 1 0

0 B3 A3 B2 A2 B1 A1 B0 A0

Short circuit 
diagnosis 

0 normal
1 short circuit

1 B7 A7 B6 A6 B5 A5 B4 A4

2 B11 A11 B10 A10 B9 A9 B8 A8

3 B15 A15 B14 A14 B13 A13 B12 A12

4 B19 A19 B18 A18 B17 A17 B16 A16

5 B23 A23 B22 A22 B21 A21 B20 A20

6 B3 A3 B2 A2 B1 A1 B0 A0

Open circuit 
diagnosis

0 normal
1 short circuit

7 B7 A7 B6 A6 B5 A5 B4 A4

8 B11 A11 B10 A10 B9 A9 B8 A8

9 B15 A15 B14 A14 B13 A13 B12 A12

10 B19 A19 B18 A18 B17 A17 B16 A16

11 B23 A23 B22 A22 B21 A21 B20 A20

 CIEFB protocol, RWR area

 CIEFB protocol, RX area
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5.3 Output data

Byte
Bit

Remark
7 6 5 4 3 2 1 0

0 B3 A3 B2 A2 B1 A1 B0 A0

Coil state 
0 disconnected

1 output

1 B7 A7 B6 A6 B5 A5 B4 A4

2 B11 A11 B10 A10 B9 A9 B8 A8

3 B15 A15 B14 A14 B13 A13 B12 A12

4 B19 A19 B18 A18 B17 A17 B16 A16

5 B23 A23 B22 A22 B21 A21 B20 A20

6
The reset coil is short-circuited or open. When the fault needs to be 
restored, first change to 0x5A, and then change to 0xA5 within 500ms 
to complete the reset.

−

Byte
Bit

Remark
7 6 5 4 3 2 1 0

0 B3 A3 B2 A2 B1 A1 B0 A0

Coil state 
0 disconnected

1 output

1 B7 A7 B6 A6 B5 A5 B4 A4

2 B11 A11 B10 A10 B9 A9 B8 A8

3 B15 A15 B14 A14 B13 A13 B12 A12

4 B19 A19 B18 A18 B17 A17 B16 A16

5 B23 A23 B22 A22 B21 A21 B20 A20

Byte
Bit

Remark
7 6 5 4 3 2 1 0

6
The reset coil is short-circuited or open. When the fault needs to be 
restored, first change to 0x5A, and then change to 0xA5 within 500ms 
to complete the reset.

−

 EtherNet/IP, PROFINET, EtherCAT protocol

 CIEFB protocol, RY area

 CIEFB protocol, RWW area
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6.1 LED display and setting

No. Code Display Function

1 MS

Green
Always on Working status: the equipment is operating normally

Flashing 1HZ Standby: the device is not configured

Green/ Red Alternate flashing Self-test: The device is undergoing a power-on test.

Red

Flashing 1HZ Recoverable failure

Always on Unrecoverable failure

Shut down US no input voltage

2 NS

Green
Always on Connected

Flashing 1HZ Not connected

Green/ Red Alternate flashing Self-test: The device is undergoing a power-on test

Red

Flashing 1HZ Connection timed out

Always on IP duplicate

Shut down US has no input voltage or no IP address

RUN

ERR

L/A IN

L/A OUT

MS/SF

NS/BF

ACT1

LK1

ACT2

LK2

US

UA

E/IP  PN

ECT  CIE

EtherNet/IP
Status Indicator

1

2

3

4

5

6

7

8

MS

NS

ACT1

LK1

ACT2

LK2

US

UA

6. EtherNet/IP Communication Configuration
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6.1 LED display and setting
 EtherNet/IP communication configuration

 Pay attention: 
Recoverable failure: configuration issue or incorrect protocol switch.  
Solution: switch to another protocol first, then switch back to the required protocol.

 Non-recoverable failure: send it back to the manufacturer for inspection and repair.

No. Code Display Function

3 ACT1 Yellow
Flashing Device (IN) send/receive Ethernet frame

Shut down The device (IN) did not send/receive Ethernet frames

4 LK1 Green
Always on Device (IN) connected to Ethernet

Shut down The device (IN) is not connected to the Ethernet

5 ACT2 Yellow
Flashing Device (OUT) send/receive Ethernet frame

Shut down The device (OUT) does not send/receive Ethernet frames

6 LK2 Green
Always on Device (OUT) connected to Ethernet

Shut down The device (OUT) is not connected to the Ethernet

7 US
Green Always on Input voltage is normal

Red Flashing Low input voltage (<18V)

8 UA

Green Always on The output voltage is normal

Red Flashing Low output voltage (<18V)

Red Always on No output voltage (<11V)
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6

6.2 Integrated in AB Studio 5000
 Here, you will see an example of how to integrate this moduleinto Studio 5000, taking L16CR 

PLC as an example:

6.2.1. New Construction:

 Open Studio 5000 > NEW Project > choose 1769-L16ER-BB1B > 
input filename > click Next

 Select 0 Modules > click Finish
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6.2.2. Import EDS configuration file

 Configuration file MVE2-EIP.eds

 Pull down TOOLS > select EDS Hardware Installation Tool

 Continue to the next step to the figure below > click Browser > 
find the configuration file > next to completion
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6.2.3. Add device

 Right click EtherNet > New Module

 Search 007F11 > select the search result > Create
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6.2.3. Add device

 Name the new device > set the IP address (same as the dial code) > OK

 Close the interface
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6.2.4. Connect to Ethernet

 Search for equipment > select PLC-GO Online 
(note: first confirm the correct valve island IP and protocol type)

 Download the PLC program (customers can write by themselves according to 
their needs, this example is empty)
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6.2.4. View input and output parameters

 After the device is correctly connected, click Controller Tagsto view the input and output 
data of the module. There is noabnormality in the input monitoring in the figure below. 
After 007F11:O.Data[0:5] is set to 16#FF, all the 48 coils willoperate. Data content 
reference: Chapter 5 Communication Module Data
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7.1 LED display and setting

No. Code Display Function

1 SF Red

Shut down Working fine

Flashing 3s 1HZ System error

Always on Working fine

2 BF Red

Shut down No data exchange

Flashing Bus start

Always on No configuration; or low-speed physical link; or no physical link

3 ACT1 Yellow
Flashing 1HZ Device (IN) send/receive Ethernet frame

Always on The device (IN) did not send/receive Ethernet frames

4 LK1 Green
Always on Device (IN) connected to Ethernet

Shut down The device (IN) is not connected to the Ethernet

5 ACT2 Yellow
Flashing Device (OUT) send/receive Ethernet frame

Shut down The device (OUT) does not send/receive Ethernet frames

6 LK2 Green
Always on Device (OUT) connected to Ethernet

Shut down The device (OUT) is not connected to the Ethernet

7 US
Green Always on Input voltage is normal

Red Flashing Low input voltage (< 18 V)

8 UA

Green Always on The output voltage is normal

Red
Flashing Low output voltage (< 18 V)

Always on t (< 11 V)

RUN

ERR

L/A IN

L/A OUT

MS/SF

NS/BF

ACT1

LK1

ACT2

LK2

US

UA

E/IP  PN

ECT  CIE

PROFINET
Status Indicator

1

2

3

4

5

6

7

8

SF

BF

ACT1

LK1

ACT2

LK2

US

UA

7. PROFINET Communication Configuration
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7.2 Integrated in SiemensTIA Portal V15
 Here, you will see an example of how to integrate this moduleinto TIA Portal V15, taking 

S7-1200 as an example:

7.2.1. New Construction

 Create a new project > enter the project name > create

 Equipment and network > add new equipment > select theappropriate PLC 
and CPU model > add
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7.2.2. Import GSD configuration file

 Configuration file: GSDML-V2.34-Mindman-MVE2-PFN-20200808

 Option drop-down > manage general station description

Option

Manage general station 
description files (GSD(D))

 1 browse GSD file path > complete
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7.2.3. Add device

 Device and network > search for 007F11 under the hardware catalog > 
drag MVE2-PFN into 4 places

 Click Unassigned > select PLC.PROFINET interface 1
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 Double-click MVE2-PFN to enter the device overview, configure the output data size in 
slot 1 according to the number of coils; firstright click to delete the slot 1 configuration, 
and then drag theparameters to slot 1

Number of coils Preferences

1...8 Output 1 Byte

9...16 Output 2 Byte

17...24 Output 3 Byte

25...32 Output 4 Byte

33...40 Output 5 Byte

41...48 Output 6 Byte
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7.2.4. Connect PROFINET

 Click to go online > start search > select PLC > go online 
(note: make sure the protocol type is correct)

7.2.5. View input and output parameters

 After the device is correctly connected, click the monitoring table to view the input and 
output data of the module. Datacontent reference: Chapter 5 Communication Module 
Data.
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8.1 LED display and setting

RUN

ERR

L/A IN

L/A OUT

MS/SF

NS/BF

ACT1

LK1

ACT2

LK2

US

UA

E/IP  PN

ECT  CIE

EtherCAT
Status Indicator

1

2

3

4

RUN

ERR

L/A IN

L/A OUT
5

6

US

UA

No. Code Display Function

1 RUN Green

Shut down Device is in INIT state

Flashing 2.5HZ Pre-operation: The equipment is in pre-operationstate

Flashing 1HZ Safe operation: the equipment is in a safe operation state

Always on Running: the device is running

2 ERR Red

Shut down No error: EtherCAT communication of the deviceis working

Flashing 2.5HZ Invalid configuration

Flashing 1HZ Local error

Flashing Application monitoring time out

3 L/A 
IN Green

Always on Link: Connect to the Ethernet, do not send/receive EtherNet

Flashing Activity: The device connects to the EtherNet and sends/receives 
EtherNet

Shut down The device is not connected to the EtherNet

4 L/A
OUT Green

Always on Link: Connect to the EtherNet, do not send/receive EtherNet

Flashing Activity: The device connects to the EtherNet and sends/receives 
EtherNet

Shut down The device is not connected to the EtherNet.

5 US
Green Always on Input voltage is normal

Red Flashing Low input voltage (< 18 V)

6 UA

Green Always on The output voltage is normal

Red
Flashing Low output voltage (< 18 V)

Always on No output voltage (< 11 V)

8. EtherCAT Communication Configuration



EtherCAT Communication Configuration8

27

8.2.1. Add PLC path

 Open Edit Routes

8.2 Integrated in BECKHOFF TwinCATXAE
 Here, you will see an example of how to integrate this module into TwinCAT XAE, taking 

CX5050 PLC as an example:

 Click Add…；Add Route Dialog
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 Broadcast Search > Select PLC(CX-3D0A4) > Add Route

 Enter the default password "1" > click OK to complete the PLC path addition
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8.2.2. Add configuration file

 Configuration file: MVE2-ECA V4.6.0

 Copy the file to the following path to complete the configuration file addition: 
C:\TwinCAT\3.1\Config\IO\EtherCAT
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8.2.3. New Construction

 Open TwinCAT XAE software 

 File > New > Project

 Select TwinCAT XAE Project > enter name > Confirm

Confirm
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8.2.4. Select the target system

 SYSTEM-Choose Target System > Select PLC(CX-3DB0A4) > OK

8.2.5. Add valve terminal

 Pull down the IO option > DEVICES-SCAN; for the valve island

 Select valve terminal Device 3 (EtherCAT) > OK
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8.2.6. Link the PLC program to the valve terminal IO

 PLC > add new item > Standard PLC Project > input name > add

 Define 6 BYTE variables in the PLC program and assign them a value of 255. 
255 means that the 8 IO values of the variable connection are all 1. As shown 
in the figure below, the program realizes that all 48 IO outputs are 1.For 
specific IO settings, please refer to Chapter 5 Communication Module Data

Add new item (W)

Add
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 Right click the PCL program project (TEST Project) > Generate

 Pull down TEST Instance > select the parameter to be associated, right click 
> Change Link
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 Select the valve terminal parameters that need to be associated and complete the 
association

 The following icon shows that the association has be successful. 
After downloading the program, the output of the 48 coils is all 1.
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9.1 LED display and setting

RUN

ERR

L/A IN

L/A OUT

MS/SF

NS/BF

ACT1

LK1

ACT2

LK2

US

UA

E/IP  PN

ECT  CIE

CIEFB
Status Indicator

1

2

3

RUN

ERR

L/A IN

4

5

US

UA

No. Code Display Function

1 RUN Green

Shut down The module is not connected

Flashing 2.5HZ The module is not connected

Flashing 1HZ The module is not connected

Always on Operation: The device is in operational status

2 ERR Red
Shut down The module is functioning properly

Always on Communication error

3 L/A 
IN Green

Always on Connected but not communicating

Flashing The module is functioning properly

Shut down Not connected

4 US
Green Always on Input voltage is normal

Red Flashing Low input voltage (<18V)

5 UA

Green Always on The output voltage is normal

Red
Flashing Low output voltage (<18V)

Always on No output voltage (<11V)

9. CC-Link IEFB Communication Configuration
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9.2 Integrated in mitsubishi FX5U
 Here, you will see an example of how to integrate this module into GX Works3, taking 

FX5U PLC as an example:

 Select the appropriate CSPP configuration file > Login

9.2.1. Adding configuration files

 Open software (without creating a new project) > Tool > 
Configuration file management > Login
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9.2.2. New project file

 Project > New > Select series and model > Confirm

9.2.3. Basic configuration

 Parameters > Module parameters > EtherNet port > Set IP according to project requirements
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 Setup using CC-Link IEF Basic

 Network configuration settings > Double click for detailed settings > 
Automatic detection of connected devices

 The connection shown in the figure below is successful
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 Specify the software component name and starting address

 Soft component/buffer storage batch monitoring - Setting D0, D1, D2 
(corresponding to RY output data) to 1, all 48 coils can be seen as output

9.2.4. Configure the starting address

 Refresh Settings > Double-click Detailed Settings
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10.1 Open configuration software
 Open the configuration software MVE2Tool.exe.

 Software interface introduction

 In EtherNet/IP or CIEFB mode, it is necessary to change the default domain. For example, 
in EtherNet/IP mode, the default domain is 192.168.1.XXX, while in CIEFB mode, it is 
192.168.3.XXX. The difference between the two protocols lies in their default domain 
settings.

10. Domain Change

MVE2Tool

La
ng

ua
ge

 sw
itc

h (
Ch

ine
se/

En
gli

sh
)

Disp
lay

 va
lve

 is
lan

d i
nte

rfa
ce

Ex
it i

nte
rfa

ce
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10.2 Set IP
 In EtherNet/IP mode: Set the DIP switch to 001, and the valve terminal address to 

192.168.1.1 (Using EtherNet/IP as an example, the default domain for CIEFB is different).

 In CIEFB mode: Set the DIP switch to 501, and the valve terminal address to 192.168.3.1.

 Set the network card and valve terminal in the same domain.  
The computer IP address is configured as follows:

X100 X10 X1

0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1 0
9

8
7

6 5
4

3
2

1

  The computer IP address is configured as follows (S)

 IP Address (I):

 Subnet Mask (U):

 Default Gateway (D):

192 .  168 .    1    .  200

255 .  255 .  255 .    0

192 .  168 .    1    .    1
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10.3 Connect the valve terminal
 Please proceed with the valve island connection steps.

 Click on the main window (enter the initial interface of the software) "Display 
Valve Manifold Interface", select the corresponding network card, fill in the correct 
valve terminal IP, and click "Connect". After the software prompts the successful 
connection, it will automatically switch to the function interface.
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10.4 Write new address
 Open the configurat

1. Fill in the IP address that 
needs to be changed.

2. Clicking will prompt a 
successful modification.

 Attention:  
After successfully modifying, the valve terminal needs to be powered off. 
Then, use the DIP switch to modify the last digit of the valve terminal's IP address.

 After modification, please annotate the new domain location on the identification 
board (Only applicable to two communication protocols: EtherNet/IP and CIEFB; 
PROFINET and EtherCAT do not require modification through this software.)
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